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SEMS PC Utility V.1.26

NOTE SULLA SICUREZZA

Prima di utilizzare il SEMS leggere quanto segue

La MPB Srl fa ogni sforzo per produrre e vendere prodotti seguendo le piu aggiornate
norme di sicurezza e per poterli offrire ai propri clienti con il piu alto grado possibile di
sicurezza.

La strumentazione qui di seguito descritta e stata realizzata e testata in accordo con
le norme europee in vigore e ha lasciato il reparto di produzione conforme alle norme
di sicurezza. Per mantenere queste condizioni seguire con attenzione quanto
descritto in questo manuale.

Il SEMS e stato progettato per essere utilizzato solamente in ambienti industriali o in
laboratori da personale qualificato. La MPB Srl declina ogni responsabilita per un uso
del prodotto diverso da quello per cui é stato progettato.
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Dichiarazione di Conformita

(in accordo alla ISO/IEC 17050-1)

Questo documento certifica che il prodotto: SEMS / SEMS LIGHT
(Sistema di misura di efficienza di schermatura)

e conforme ai seguenti Standard Europei:
Sicurezza: CEI EN 61010-1 (2002)
Compatibilitd Elettromagnetica: EN 61326-1 (2007)
Questo prodotto & conforme con i requisiti della Direttiva Bassa Tensione
2006/95/CE e con la Direttiva EMC 2004/108/CE.

MPB S.r.l.
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1. Informazioni Generali
1.1. Introduzione

I SEMS e stato ideato per soddisfare le crescenti esigenze di collaudo / verifica
dell’efficienza di schermatura degli ambienti schermati in ambito ospedaliero ed
industriale.

Tale sistema di misura permette di determinare con estrema precisione il valore
dell'attenuazione del campo magnetico ed elettrico degli ambienti schermati in modo
completamente automatico e con la massima rapidita.

1.2. Descrizione Sistema

Il sistema di misura di efficienza di schermatura SEMS & composto da una parte
trasmittente e da una ricevente, entrambi utilizzano coppie di antenne dalle
dimensioni contenute, per misurare [lattenuazione del campo magnetico e
I'attenuazione del campo elettrico.

Contrariamente ai sistemi presenti sul mercato, che misurano [l'efficienza di
schermatura solo su pochi punti di frequenza, il sistema SEMS permette di effettuare
il test completo su tutto il range di frequenza in modo continuo.

Un’ ulteriore miglioria rispetto ai sistemi classici € la sincronizzazione delle due parti,
TX ed RX, che colloguiano tra di loro tramite un sistema wireless permettendo cosi di
eseguire le misurazioni limitando al massimo gli eventuali errori dell’operatore.

Sistema SEMS

Foto n. 01
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1.3. Composizione Sistema SEMS KIT 1, SEMS LIGHT ed

accessori opzionali

Modello

SEMSKIT 1

SEMS
LIGHT

Unita RX (10kHz...300MHz)

v

Solo fino a
128 MHz

Unita TX (10kHz...300MHz)

Antenne Biconiche Mod. B1 (60...300MHz)

Antenne Rod Mod. R2 (1...128MHz)

Antenne Loop Mod. L1 (2...128MHz)

Antenne Loop Mod. L2 (10kHz...4MHz)

Antenna Loop Mod. L3 per ricerca guasti
discontinuita

Antenne Dipoli Mod. D1 e D2 (40...300MHz)

Chiavi RS/232 Wireless a tecnologia Bluetooth

RS232/USB cavo per programmazione e scarico
dati

SN0 OOIKNOK[N

SO OJ0IK[0O|0|«

Caricabatterie

Valigia Trasporto Mod. SEMS-CC

Adattatori connessione antenne N(m)-N(m)

Cal-Kit 4 attenuatori 30 dB/cad

Cal-Kit Certificato Accredia

Treppiedi in fibra di vetro Mod. NMR-01 A
regolabile in altezza ed amagnetico

Link ottico con 20 m di fibra

Software Mod. SEMS-SW

Manuale operativo su chiavetta USB

Certificato di taratura standard SEMS-STD

ANRNENIGIEENOGIGIIGIRANRNEN

NENAN[e]lNolle]le]ANRENAN

Opzione O

iy
Lo B4

™
/ o

/™

Loop Mod.L2 Rod Mod.R2 Tripode Mod.NMR-01 Dipoli Mod. D-1
Dipoli Mod D-2

Foto n. 02
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SUGGERIMENTI PER OTTENERE UNA MAGGIORE DINAMICA CON LE ANTENNE DIPOLO
MODELLO D-1 e D-2

DIPOLC D1

Element 4

|
DIPOLO D2

Element 5

il

Frequency range| Extended
[MHz] element
200-300 0
140-240 0+1
90-180 0+1+2
70-140 O+1+2+3
A0-120 0+1+2+3+4

Frequency range| Extended
[MHz] element
260-300 0
170-250 0+1
140-180 O+1+2
115-155 0+1+2+3
80-120 0+1+2+3+4
A0-115 0+1+2+3+4+5
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1.4. Frontale Ricevitore

Nella Foto n. 03 é raffigurato il pannello frontale del ricevitore. E’ composto dalla
parte di visualizzazione (display) e dalla parte di comando (tastiera).

" Ingresso RF 50 Ohm
e T connettore N femmina
SEMS
- Display alfanumerico

ool
() (8] (=)
Tastiera

@\\

Measurement
System

Tasto di accensione

Foto n°03

1.5. Frontale Trasmettitore

Il trasmettitore del sistema SEMS (Foto n° 04) non ha nessun comando a parte |l
tasto di accensione ed il Led di indicazione trasmissione attiva. Questo e dovuto al
fatto che i comandi gli vengono inviati dal ricevitore tramite 'interfaccia wireless.

| Uscita RF 50 Ohm
e connettore N femmina

Tasto di accensione

Shielding
Effectiveness
Measurement

Symom LED indicazione
- trasmissione attiva

Foto n°04
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1.6. Pannello Inferiore Ricevitore / Trasmettitore

| pannelli inferiori (Foto n° 05) sono uguali per entrambi gli apparecchi e contengono,
oltre che il numero di serie e la presa filettata per il fissaggio su un treppiede, il
connettore per il caricabatterie in dotazione e la presa RS232 utilizzabile per il link

wireless.

Foto n°05
Presa
Numero RS232
di serie
Presa filettata Connettore per
Ya di pollice caricabatterie

Nota importante: Al connettore per il caricabatterie deve essere connesso solo
ed unicamente il caricabatterie in dotazione, la connessione accidentale con un altro
tipo di caricabatterie pud provocare seri danni oltre che allo strumento anche alle

persone.

Nota importante: | caricatori del Tx e dell’Rx vanno utilizzati sempre ad apparati
spenti.
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1.7. Specifiche Tecniche

Range di Frequenza del TX/RX

10 kHz...300 MHz (128 MHz versione

Risoluzione SEMS Light)
10 Hz
Uscita RF (modulo TX) Zout 50 Q, N fem.
Potenza max in uscita (tipica) +30 dBm
Ingresso RF (modulo RX) Zin 50 Q, N fem.
VSWR < 1.2
Attenuatore 0...20dB
Livello Max ingress 110 dBuv
Dinamica 120 dB
IF bandwidth (Modulo RX) 3 dB (BW) 5/150Hz
Accuratezza misura di attenuazione 10 kHz...30 MHz +1.0dB
(tipica) 30 MHz 300 MHz +15dB

Interfaccia I/O

RS232 / Wireless

Allarme acustico

Programmabile sul livello di attenuazione

Conformita Normative Internazionali

MIL-Std-285 |EEE Std 299 EN 50147-1
NSAG65-6

Temperatura Operativa

0°....40°C

Alimentazione a Batterie

Li-lon ricaricabili non sostituibili
dall’'operatore (durata 6 h)

Antenne
Loop Mod.L-1

Loop Mod.L-2

Rod Mod. R-2

Dipoli D-1/D-2

Loop L-3

Biconica Mod. B1

Range di Frequenza 2...128 MHz
Diametro 30 cm

Range di frequenza 10 kHz...4 MHz
Diametro 30 cm

Range di frequenza 1 MHz...128 MHz
Regolabili in apertura

Range di frequenza 40...300 MHz
Regolabili in apertura

Utilizzabile per test RF Leak fino a 300 MHz

Range di frequenza 60...300 MHz
Larghezza 35 cm

Accessori
Treppiedi in vetroresina Mod. NMR-01
Link ottico con 20 m di fibra

Regolabili in altezza e amagnetico

Set-Up Calibrazione e Misura

Pre-programmabili dall’operatore tramite
software

Peso e dimensioni
Peso complessivo
Dimensioni Valigia

9,4 kg
52x43x23cm

Le specifiche tecniche possono subire variazioni senza alcun preavviso

-10 -
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1.8. Ricarica delle batterie

Per ricaricare il dispositivo & necessario scollegare le chiavette wireless o

'eventuale cavo RS232.
Connettere in sequenza:

a) il carica batterie alla rete elettrica ed attendere I'accensione del led Verde sul

caricatore

b) Il jack del caricabatterie al SEMS

Durante la fase di ricarica, Il LED del carica batteria € ROSSO.

La fine della ricarica viene segnalata dal LED VERDE.

A batterie completamente scariche il tempo di ricarica e di circa 4 ore.

Attenzione: | carica batterie potrebbero avere dei valori di tolleranza sul controllo di
fine carica differenti. Cio non pregiudica il corretto funzionamento del ciclo di carica
ma potrebbe dare indicazione di LED verde (carica completa) in tempi leggermente

differenti.

-11 -
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2. Principio di funzionamento

2.1. SEMS Ricevitore

Lo schema a blocchi sintetico in Figura a) rappresenta la parte ricevente del SEMS.

Parte digitale

IFf\IF Attenuatore | > Filtri > ADC > | Display
RSP
DSP

Figura a)

Seguendo il segnale RF che giunge dallantenna ricevente si trova il modulo
attenuatore che ha il compito di adeguare il livello del segnale RF agli stadi successivi,
segue il modulo filtri che seleziona le bande a seconda della frequenza di ricezione.
Il segnale RF cosi adattato entra nella parte digitale tramite il convertitore analogico
digitale (ADC) a cui seguono un RSP e un DSP che per mezzo di algoritmi complessi
elaborano il segnale digitale per poi rappresentarlo sul display.

2.2. SEMS Trasmettitore

La parte trasmittente del SEMS e rappresentata sinteticamente dalla Figura b)

Parte digitale

Finale RE
CPU > | Doubler | > di ouT
DDS potenza

Figura b)

Il segnale da trasmettere viene generato dal DDS seguendo i comandi della CPU che
riceve le istruzioni dall'interfaccia wireless del ricevitore, tale segnale viene quindi
duplicato e poi amplificato per raggiungere il livello necessario per poi essere
applicato all’antenna di trasmissione.

-12 -
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2.3. SEMS Sistema

Lo scopo del sistema SEMS €& quello di misurare l'efficienza di schermatura di un
ambiente schermato, cioé di misurare I'attenuazione del campo elettrico e magnetico
che ha tale ambiente.

Il SEMS effettua una misura “relativa” e non assoluta.

Il principio di funzionamento del sistema si puo brevemente cosi esporre:

La parte trasmittente genera un segnale RF che tramite I'antenna viene irradiato.

A una distanza prefissata c’e il ricevitore che per mezzo di una analoga antenna
riceve tale segnale e ne misura il livello. Se noi spostiamo il ricevitore all'interno
dellambiente da misurare, mantenendo la stessa distanza dal trasmettitore,
otteniamo una riduzione del segnale misurato.

Dala differenza delle due misurazioni si ottiene il risultato voluto, cioe I'attenuazione
dell’ambiente.

D - AZZERAMENTO

Distanza per
|'azzeramento.
dal centro antenna s

[

Esempio del set-up di azzeramento del sistema con antenne loop

Foto n°06

2.4. Risparmio energetico e ricalibrazione

I SEMS ha integrati allinterno delle unita TX ed RX dei timer per due differenti
ragioni: I'unita TX si spegne automaticamente dopo 17 minuti di inattivita per
preservare la batteria; 'unita RX passati 15 minuti dall’'ultima procedura di zero
suggerisce di ricalibrare il SEMS ripetendo 'azzeramento.

-13-
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3. Uso efunzionamento del Sistema

3.1. Accensione e Menu

Premendo brevemente il tasto di accensione dellunita RX si ottiene l'avvio
dell’apparecchio, per lo spegnimento occorre tenere premuto lo stesso tasto per
almeno 4 secondi. La stessa procedura vale anche per l'unita Tx.

Avvenuta I'accensione il display rappresentera la seguente schermata.

Sul display I'icona della batteria in alto a destra indica la carica dell'unita RX, dopo
pochi secondi sulla sinistra apparira quella di carica dell’'unita TX.

“Se non compare licona della batteria sulla sinistra del display, non c’é
comunicazione tra i due dispositivi. Per questo si raccomanda di verificare la corretta
configurazione dei dispositivi wireless” (Par. 3.5- pag 32)

SEMS |
FW — 1.32 27/03/14
HW-2
Wiz  Std Stp
I I I LI

NOTA: Nel caso appena stabilita la connessione, i led rossi dei dispositivi Wireless
lampeggiano assieme a quelli gialli, attendere il completo spegnimento dei primi per
permettere ai dispositivi di sincronizzarsi e garantirne il corretto funzionamento.

3.2. Menu Std

Premendo il menu Std si ottiene la seguente schermata.

SEMS B
FW —1.32 27/X03/14

Show Cal

Poi premendo il tasto corrispondente alle due possibili scelte Show e Cal si entra nei
rispettivi menu.

-14 -
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3.2.1. Menu Cal

Il menu Cal serve ad eseguire 'azzeramento (Scan o List) e la taratura (CalK) del
sistema

N SEMS N

Ready for Measuring

Scan List CalK
Il Il Il Il

Scan serve ad azzerare il sistema utilizzando delle scansioni di default o
programmabili, infatti premendo tale tasto appare un’ulteriore menu dove si possono
scegliere degli scan di default (L_Lo, L_Hi e Bic) oppure User dove si possono
scegliere degli scan programmabili (Scl, Sc2, Sc3 e Sc4) pre-caricati dall’operatore
tramite software “SEMS PC_ Utility”

N SEMS |
Ready for Measuring

L Lo L _Hi Bic User
Il I Il Il

A seconda delle antenne collegate, selezionare il tasto corrispondente:
L_Lo ( coppia antenne Loop Mod. L2)

L_Hi ( coppia antenne Loop Mod. L1)

Bic (coppia antenne Biconiche Mod. B1)

-15 -
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Visualizzazione User:

i SEMS N

Ready for Measuring

Scl Sc2 Sc3 Sc4
I I I Il

List serve ad azzerare il sistema utilizzando delle liste di frequenze di default o
programmabili, infatti premendo tale tasto appare un’ulteriore menu dove si puo
scegliere la lista di frequenza di default DFT oppure tre liste programmabili (L1, L2
elL3)

i SEMS N

Ready for Measuring

DFT L1 L2 L3
I I I I

CalK serve a calibrare il sistema utilizzando i 4 attenuatori da 30 dB forniti come
accessori opzionali Cal-Kit

NOTA: La procedura d calibrazione necessita del collegamento wireless tra TX ed
RX, a conferma del collegamento avvenuto apparira I'icona della batteria del TX sulla
sinistra del display del RX.

Attenzione!
Non effettuare MAI la procedura di calibrazione con i caricabatterie collegati

-16 -
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3.2.2. HiDyn e una particolare funzione che si attiva soltanto se si vogliono utilizzare
un numero massimo di 30 frequenze. Con questa modalita, I'operatore, in fase di
azzeramento, riesce a capire immediatamente se in aria sono presenti dei
radiodisturbi a frequenze identiche a quelle di test che potrebbero andare a ridurre la
gamma dinamica effettiva compromettendo quindi i risultati.

La ricerca puo essere effettuata in modalita manuale o automatica. Per far cio é
necessario andare sul menu “Stp” mostrato in figura

SEMS
FW —1.32 27/03/14
HW-2

BEEP Clear

e premere il tasto “BEEP”

+1

BEEP ON

Use arrows for
10 dB step

-1 ON

100d8 §

OFF

L’attivazione/disattivazione del BEEP (ON/OFF), impostera I'esecuzione manuale o

automatica di “Best Dynamic”.

E’ inoltre possibile con l'ausilio delle frecce del tastierino impostare la soglia di
dinamica da considerare in fase di misura.

-17 -
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Se per esempio, prima dello zero, si imposta il valore a 100 dB (con BEEP “On”)
I'operatore sapra immediatamente se potra disporre di questa dinamica ancor prima
di lanciare la misura.

@ 9,900001 MHz |

Dynamic :85 dB
** Above Minimum **

Abort OK
Il Il Il Il

In questo esempio l'operatore sapra immediatamente di quanta dinamica potra
disporre in fase di misura alla frequenza di 9,900001 MHz.Confermando con “OK” il
SEMS procedera al punto successivo di frequenza attivando la funzionalita “Best
Dynamic” nel seguente modo:

Per ogni frequenza di test vengono aggiunte due frequenze laterali supplementari:
La piu bassa sara F * 0,99 (-1%) e la piu alta F * 1.01 (+1%)

Tutte le frequenze vengono sintonizzate sull'unita RX, mentre l'unita TX rimane in
OFF, e per ogni singola frequenza viene registrato il rumore di fondo.

Al termine di questa fase, su ogni tripletta di frequenze, quella che mostrera la figura
di rumore piu bassa verra presa in considerazione, mentre le altre due saranno
scartate.

In questo modo, all'interno dell’'unitd RX verra creata una nuova tabella di frequenze
di pari numero a quelle scelte in origine.

-18-
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E’ possibile in qualsiasi momento interrompere la funzione “Best Dynamic”

Premendo il tasto “Abort” comparira il seguente menu:

B SemsUnZerced |

Calibration Aborted
** Above Minimum **

Show Cal

E’ inoltre possibile andare a visionare tutti i valori di dinamica disponibili per ogni
punto di frequenza prima di lanciare la misura tramite il comando Show:

| Sems |

Ready for Measuring

Meas Show Cal Snif
Il Il Il Il

e poi Dyn:

Sems |

Ready for Measuring
** Above Minimum **

Dyn L1-4 M1-4 H1-4
| | | |

-19-
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Per poi visualizzarli uno ad uno con i comandi NxFr ( prossima frequenza) o HiPk
( picco piu alto) ed in ultimo NxPk ( prossimo picco rispetto a quello visualizzato)

Dynamic
9.900 to 126.000

1stF  NxFr HiPk NxPk
Il Il Il Il

-20 -
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3.2.3. Menu Show

I menu Show serve a
precedentemente

visualizzare le misure eseguite e memorizzate

Per visualizzare le misure salvate, premere il tasto Show

Meas Show Cal

SEMS
Ready for Measuring

Snif

Scegliere le misure salvate nella memoria H1-4

Last

SEMS
Ready for Measuring

L1-4 M1-4 H1-4

Richiamare quelle della memoria H-1

SEMS
Ready for Measuring

H-1 H-2 H-3 H4

-21 -
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1stF visualizza I'attenuazione corrispondente alla prima frequenza della scansione
o della lista

NXFr Visualizza I'attenuazione corrispondente alla frequenza successiva
HiPk Visualizza I'attenuazione minima dell’intera scansione o lista
NXxPK Visualizza I'attenuazione minima successiva

N Dynamic |
60.000 to 300.000

1stF NxFr HiPk NxPk
Il Il Il Il

Premendo il tasto corrispondente a Last si ottiene la visualizzazione dell’ultima
misura effettuata, con gli altri tre tasti si possono visualizzare le misure memorizzate.
(fino a 4 per ogni tasto)

Quando si e scelta la misura da rappresentare si puo analizzare frequenza per
frequenza l'attenuazione misurata.(le frequenze sono sempre rappresentate in MHz)

Con il tasto ESC si ritorna al menu precedente.

3.2.4. Menu Meas

Il comando Meas fa parte del menu Std, ma appare soltanto dopo aver effettuato
'azzeramento tramite il comando Cal descritto nel precedente paragrafo 3.2.1. del
presente manuale.

| SEMS N
Ready for Measuring

Meas Show Cal Snif
Il Il Il Il

-22 -
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Il comando serve ad eseguire la misura dell’attenuazione in modo automatico (Auto),

oppure in modo manuale (Man).

Auto

Fully Zeroed

Ready for Measuring

Man

PreQ Unc

Eseguendo il test in modo

automatico si

potra scegliere di farlo partire

immediatamente (Now), oppure attendere un tempo prefissato (10s, 30s, e 60s).

Now

SEMS

Ready for Measuring

10s 30s

60s

Se invece si desidera eseguire il test in modo manuale si dovranno utilizzare i
comandi: (Prev) frequenza precedente, (Next) frequenza successiva, (Redo)
ripetizione frequenza e (Abort) per uscire.
Per la misura della componente elettrica si consiglia I'utilizzo delle antenne Rod Mod.
R-2, completamente aperte, oppure delle Biconiche B-1 sulle due unita RX e TX. Per
il campo magnetico si possono utilizzare le coppie L-1 o L-2

Prev

60.000000 MHz
Rbw:40 Hz.
Att:56 dB

Next

Redo Abort

-23-
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Terminato il test 'apparecchio chiedera di salvare le misure in una delle 4 memorie
per ogni range di frequenza:

Range frequenza da 0.01 a 2 MHz = memoria (L-1, L-2, L-3 e L-4)
Range frequenza da 2 a 60 MHz = memoria (M-1, M-2, M-3 e M-4)
Range frequenza da 60 a 300 MHz = memoria (H-1, H-2, H-3 e H-4)

Qualora dovesse esserci sovrapposizione tra frequenze estreme, viene proposta la
prima memoria trovata libera.
Per esempio, a 60 MHz si potrebbe avere una proposta tra M o H

Esempio di richiesta salvataggio nel range 60...300 MHz:

Scan Terminated

Press 1-4 to save
or Escape

H-1 H-2 H3 H-4
I I I I

Premendo il tasto H-1 i dati saranno salvati e si tornera alla schermata iniziale.

3.2.5. Menu Snif

Da questo Menu é possibile effettuare le misure su una singola frequenza per lo
sniffing dei leaks.

137.520975 MHz |

RBW: 40Hz
to 137.520975

Next Prev
Il Il Il Il

-24 -
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Premere Next o Prev per selezionare la frequenza di lavoro desiderata per lo

sniffer.

144.210005 MHz |§

TX Tuned and Ready
to 144.210005

Next Prev Meas

Premendo Meas il SEMS comincera a misurare l'efficienza di schermatura sulla
frequenza selezionata, mostrando I'attenuazione attuale insieme al valore massimo
e minimo racchiuso tra parentesi.

144.210005 MHz |

(112.4 : 134.4)
Att:120.1 dB

Stop Clear
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Premendo Clear il valore massimo e minimo sono resettati e Stop si interrompera
la misura.

§ 144.210005 MHz |
Sniffing terminated
(112.4 : 134.4)

Meas Show Cal Snif
Il Il Il Il

Premendo nuovamente Snif & possibile far ripartire la misura o selezionare una
diversa frequenza di lavoro.

Sitenga a mente che questa modalita operativa puo essere utilizzata in ambienti
dove la chiave RS232\Wireless Bluetooth €& inutilizzabile, permettendo, assieme alla
modalita unconnected (si consulti la relativa sezione del manuale), una completa
analisi ambientale.

| dispositivi necessitano di comunicare solo durante la selezione della frequenza.
Non appena la frequenza e stata selezionata apparira il messaggio “TX Tuned and
Ready”. Da questo momento in poi € possibile rimuovere le connessione ed iniziare
la misura. Sara necessario ripristinare la comunicazione tra l'unita RX e l'unita TX
solo nel caso in cui si voglia modificare la frequenza di lavoro.

In questa modalita & necessario utilizzare il loop Mod. L-3 come in figura foto 7

Foto 7
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3.3.

Menu WIZ

Per migliorare la gestione della procedura delle misurazioni il SEMS permette di
accedere ad un wizard che aiuta I'utente ad organizzare meglio il salvataggio dei

dati.

Per accedere al wizard bisogna premere il tasto WIZ presente nel menu iniziale
dello strumento. Entrati nel wizard lo strumento ci porra le seguenti domande:

- Scelta della camera da misurare (A, B, C, D): Attraverso le lettere A,B, Ce D
si identifica una camera schermata. Quindi l'utente dovra assegnare alle
camere su cui deve effettuare le misurazioni un’etichetta corrispondente ad
una delle quattro lettere, dopodiché indichera sullo strumento la camera sulla

guale sta operando.

Choose the
Chamber you want
To measure
B C

- Scelta del numero massimo di punti da misurare (1, 2, 4, 8): Rappresenta il
numero di punti di misura che si decide di assegnare per ogni camera. Quindi
'utente dovra numerare in ordine cronologico di esecuzione i punti sui quali
effettuare le misurazioni per ogni stanza, e questi saranno memorizzati in
maniera ordinata nello strumento.

Select the max

number of spot

to be measured
2 4
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- Scelta del numero di ranges (antenne) da misurare (1, 2, 3, 4): Rappresenta il
numero di sistemi di antenne che l'utente avra a disposizione durante lo
svolgimento delle misurazioni. Una volta effettuate le misurazioni su tutti i punti
con un tipo di antenna, lo strumento chiedera di sostituirla e di ripetere la
procedura di auto-zero.

B Selectthe number |
of ranges (antennas)
to be measured

3.3.1. Procedura per eseguire misurazioni con il Wizard

Terminata la fase in cui il wizard richiede le informazioni sulla camera, sui punti e
sulle antenne, verra richiesta la procedura di auto-zero del primo set di antenne
che si intende utilizzare.

La procedura da seguire che sara mostrata € del tutto analoga a quella mostrata
nel capitolo 3.2.1. del presente manuale.

i Choose the range |
for Antenna 1
(Zero)

Scan List

Selezionando “Scan” verra richiesto di azzerare il sistema utilizzando le scansioni

di default (L_Lo -
PC_Utility” (User).
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Choose the range i
for Antenna 1
(Zero)
L Lo L Hi Bic User
| | | |

Terminata la prima scansione comparira la schermata per la misurazione.

Tale schermata chiedera all’'utente se desidera eseguire la misura dell’attenuazione
automaticamente (Auto), o manualmente (Man). Successivamente spiegheremo la
funzione PreQ

i Fully Zeroed i
Ready for Measuring

Auto Man PreQ
Il Il Il Il

Eseguendo il test in modo automatico si potra scegliere di farlo partire
immediatamente (Now), oppure attendere un tempo prefissato (10s, 30s, e 60s).

| Fully Zeroed |
Ready for Measuring

Now 10s 30s 60s
Il Il Il Il
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Se invece si desidera eseguire il test in modo manuale si dovranno utilizzare i
comandi: (Prev) frequenza precedente, (Next) frequenza successiva, (Redo)
ripetizione frequenza e (Abort) per uscire.

60.000000 MHz
Rbw:40 Hz.
Att: 65 dB
Prev Next Redo Abort
Il Il Il Il

Dopo aver fatto questa scelta verra eseguita la misurazione, e a seguire si aprira la
schermata di gestione del wizard, attraverso la quale si puo tenere sotto controllo lo
stato della procedura.

B ChASpl2R12 §
Spot Done (115.7 dB)

Next ReDo End
Il Il Il Il

In questa schermata “Ch:A” ci ricorda che la camera (chamber) scelta € quella con
I'etichetta “A”, “Sp:1/2” ci indica il punto (spot) di misura su cui stiamo operando (in
questo esempio € il 1° di 2), ed “R:1/2” rappresenta il sistema di antenne (range) che
stiamo utilizzando (in questo esempio stiamo utilizzando il 1° di 2 sistemi selezionati).

“Spot Done” ci segnala che per questo punto € stata gia effettuata la misurazione con
il sistema di antenne selezionato, ed il valore leggibile a fianco tra parentesi é il
massimo valore di attenuazione misurato rispetto a tutte le frequenze previste dalla
misura.
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Il tasto Next ci permette di passare al prossimo punto. Qualora avessimo misurato
tutti i punti in programma, ci fa passare alla schermata di auto-zero del prossimo
sistema di antenne. Se anche i sistemi di antenne sono terminati, si ritornera alla
schermata iniziale con il messaggio di avvenuta memorizzazione dei dati.

Il tasto Redo ci porta a ripetere la misurazione sul punto che stiamo visualizzando
nella schermata, terminata tale operazione la schermata ci verra riproposta con il
valore massimo aggiornato.

Il tasto End serve ad interrompere le misurazioni con il sistema di antenne corrente.
Premendolo lo strumento ci chiedera di sostituire le antenne ed avviare la procedura
di auto-zero.

Qualora i sistemi fossero terminati la sessione gestita da wizard terminera e si tornera
alla schermata iniziale con un messaggio di avvenuta memorizzazione.

ATTENZIONE: Premendo il tasto “End” saranno eliminati tutti i punti su cui non sono
state fatte misurazioni. (Es: se selezioniamo 8 punti e ne misuriamo soltanto 3,
premendo “End” riduciamo a 3 il numero di punti in esame.

Se invece li misuriamo tutti e 8, al cambio di antenne e dopo 3 misurazioni, premendo
“End” gli 8 punti vengono conservati).
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3.4.

Il SEMS offre la possibilita di attivare un segnalatore acustico che avvisa nel caso

Menu STP

venga superato una valore di soglia impostabile dall’utente.

Per attivare questa funzione € necessario entrare nel menu “Stp” presente nel menu

iniziale che viene mostrato subito dopo I'accensione

E premere BEEP

Utilizzando le frecce in su ed in giu presenti sulla tastiera & possibile spostare la soglia

di 10 dB.

Premendo i tasti corrispondenti a +1 e -1 si seleziona il valore desiderato con step di

1 dB.

Selezionando ON si attivera la modalita nella quale durante le misurazioni verra
prodotto un segnale acustico qualora il valore di attenuazione misurato scenda sotto
il valore soglia impostato dall’'utente. ( attenzione questo tasto € multifunzione e

SEMS
FW - 1.32 27/03/14
HW-2
BEEP Clear

BEEP ON 100dB N
Use arrows for
10 dB step
+1 -1 ON OFF

puo essere utilizzato anche per la funzione di HiDyn)
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Durante il verificarsi di questa condizione il SEMS emettera una serie rapida di suoni,

alla quale seguira una serie piu lenta di suoni per qualche istante.

Premendo OFF la modalita sara disattivata.

Lo stato della modalita e riportato nel display di questo menu tramite le indicazioni
“BEEP ON” e “BEEP OFF”.

La soglia attualmente impostata e scritta in altro a destra (100 dB in questo esempio)

Clear

Con questa funzione, I'operatore ha la possibilita di cancellare tutte le misure
memorizzate all'interno dell’'unita RX

Premendo OK

WARNING
ALL Measures
Will be ERASED

Abort OK

WIZ

Memory cleared |}
No measure Left

Std Stp
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3.5 Procedura di misura dell’attenuazione di un
ambiente schermato

1) Montare il ricevitore e il trasmettitore su due treppiedi non condulttivi di circa 120
cm di altezza e ad una distanza di 40/60 cm, quando si utilizzano le antenne loop
e 100/200 cm utilizzando le antenne biconiche.

2) Connettere le antenne sia sul trasmettitore che sul ricevitore avendo cura di
orientarle in modo parallelo tra loro.

3) Connettere i due trasduttori wireless* alle rispettive prese RS232, accendere sia il
trasmettitore che il ricevitore ed assicurarsi che i led verdi dei due trasduttori
diventino accesi fissi e che le due icone delle batterie siano visibili sul display. Si
consiglia di attendere qualche minuto prima di proseguire (warm-up).

4) Eseguire 'azzeramento premendo il tasto Cal, scegliere Scan o List e la banda
voluta. (altre modalita di azzeramento sono disponibili per migliorare la dinamica
in fase di misura. Vedere capitolo voce “HiDyn”)

5) Terminata la funzione di azzeramento spostare il ricevitore all’interno o all’esterno
dellambiente schermato da testare in prossimita del primo punto di misura e il
trasmettitore nell’area opposta mantenendo tra i due la stessa distanza
dell’'azzeramento aggiungendo lo spessore della parete.

6) Eseguire la misura di attenuazione premendo il tasto Meas, Auto e 10s per dare
il tempo all’'operatore di allontanarsi di qualche metro.

7) Terminata la misura salvare il risultato scegliendo la memoria voluta.
8) Ripetere i punti 5, 6 e 7 per ogni altro punto di misura.

9) Terminati i punti di test scaricare le misure su un pc tramite il SW SEMS PC Utility
in dotazione.

* Configurazione dei due dispositivi wireless

MASTER <<----ON  OFF ---->>
ON 4 - OFF=115K ON=9600
ON 3 - AUTO MASTER
ON 2 - AUTO DISCOVER
OFF 1- FACTORY DEFAULTS
SLAVE <<----ON  OFF ---->>
ON 4 - OFF=115K ON=9600
OFF 3 - AUTO MASTER
ON 2 - AUTO DISCOVER
OFF 1- FACTORY DEFAULTS
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3.6. Calibrazione con Cal-Kit

Il sistema SEMS pur non facendo misure in valore assoluto necessita di una verifica
periodica della sua linearita, il Cal-Kit soddisfa questa esigenza in modo semplice e
preciso. In caso di necessita Il Cal-Kit puo anche essere richiesto con calibrazione

LAT.

La procedura di calibrazione si richiama dal menu Std/Cal scegliendo poi CalK, il
display indichera passo per passo I'esatta esecuzione.

Visualizzazione inserimento attenuatore 30 dB:

Insert
30 dB Attenuator
HW-2
Abort OK

Dopo aver collegato il primo attenuatore da 30 dB tra Rx e Tx premere OK

Visualizzazione inserimento secondo attenuatore:

Insert (2 X 30 dB)
60 dB Attenuator

Abort OK
Il Il Il Il

Collegare il secondo attenuatore e premere OK

Ripetere la stessa operazione fino alla richiesta dell’'ultimo attenuatore (4x30 dB= 120
dB).
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Al termine della taratura sul display comparira la seguente visualizzazione:

Calibration done
Worst: 0.70 dB
20.000 kHz (120 dB)

Show Cal

L’indicazione “Worst” indica I'accuratezza di misura di attenuazione peggiore alla
frequenza di esempio di 20.000 kHz che tipicamente deve rientrare nelle specifiche

tecniche del SEMS:

10 kHz... 30MHz + 1.0dB
30 MHz...300MHz + 1.5dB

La foto che segue raffigura il set-up da utilizzare:

Foto n°08

3.7 Misura con le antenne Rod mod. R-2
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Quando si utilizzano le rod antenne, (nella fase di azzeramento e nella fase di misura)

e assolutamente necessario connettere al solo SEMS TX

I'attenuatore da 10dB

fornito in dotazione prima di connettere la rispettiva antenna rod (vedi figura n. 09)
ATTENZIONE: il non utilizzo dell’attenuatore puo arrecare gravi danni alle

funzionalita del sistema.

Foto n. 09
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3.8. Modalita Unconnected

Alcune applicazioni di misura non sono adatte né all’'utilizzo delle chiavi
RS232\Wireless né all’'utilizzo del Link ottico Mod. LO.

Un esempio potrebbe essere una misura in un ambiente schermato senza guide
d’onda per il passaggio delle fibre ottiche sui pannelli tecnici.

Per questo genere di applicazioni ¢’é una modalita operativa specifica chiamata
Unconnected, dove, durante la misura, non & necessaria alcuna connessione tra le
unita RX e TX.

Per usare questa modalita operativa il SEMS RX deve essere programmato da
PC (attraverso il SEMS Software) con una lista massima di 20 frequenze.

La lista puo essere salvata in uno qualsiasi degli slot L 1-3.
La modalita Unconnected puo essere utilizzata sia in misure Wizard che Standard.
In modalita Standard si deve selezionare Std dal menu principale:

N SEMS N

FW — 1.32 27/03/14
HW-2
WIZ  Std Stp
I I I I

Premere Cal, poi List e successivamente lo slot della lista dove sono state salvate le
frequenze.

Procedere poi con I'azzeramento come in una normale misura.
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Appena completata la procedura di zero premere Meas:

N SEMS N

Ready for Measuring

Auto Man PreQ Unc
Il Il Il Il

Posizionare le unita TX ed RX nel punto di misura desiderato e premere Unc per
abilitare la sincronizzazione dei clock interni.
Questo passo va effettuato quando le due batterie sono visibili sul display LCD.

Remove N
Connections
and start measuring
Now 10s 30s 60s
Il Il Il Il

E’ possibile a questo punto rimuovere I'adattatore RS232\Wireless dall’'unita RX (il
simbolo della batteria dell’'unita TX scompare), chiudere la porta del’ambiente
schermato e avviare la misura.

All'avvio della misura parte un conto alla rovescia da un valore che dipende sia dal
momento di avvio della misura che dal numero di frequenze inserite nella lista.
-39-



MPB Manuale duso

SEMS

5.000000 MHz
Syncinl2s

Dopo la prima misura, prima di ogni frequenza e presente un ritardo di
sincronizzazione.

10.000000 MHz
Syncin2s
Att:88.0 dB

Appena completata la misura € possibile salvare i dati in uno slot di memoria
esattamente come si farebbe in una normale misura Standard.
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Se necessario € possibile eseguire un’altra misura selezionando nuovamente Meas:

SEMS N
Ready for Measuring

Auto
Il Il Il Il

Premendo Auto e possibile avviare una nuova misura senza dover riconnettere le
due unita. Comungue questo puo essere fatto solo per un periodo limitato di tempo
(vedere sotto).

L’utilizzo dell’'lUnconnected in modalita Wizard funziona in molto simile.

E’ possibile avviare 'azzeramento selezionando la lista programmata per la
modalita Unconnected come unico range di misura.

N Fully Zeroed N
Ready for Measuring

Auto Man PreQ Unc
Il Il Il Il

-4] -



Manuale duso
MPB
SEMS

Posizionare le unita TX ed RX nel punto di misura desiderato e premere Unc per

abilitare la sincronizzazione dei clock interni.
Questo passo va effettuato quando le due batterie sono visibili sul display LCD.

Remove N
Connections
and start measuring
Now 10s 30s 60s
Il | | Il

E’ possibile a questo punto rimuovere I'adattatore RS232\Wireless dall’'unita RX (il
simbolo della batteria dell’'unita TX scompare), chiudere la porta del’ambiente
schermato e avviare la misura.

All’'avvio della misura parte un conto alla rovescia da un valore che dipende sia dal
momento di avvio della misura che dal numero di frequenze inserite nella lista.

5.000000 MHz
Syncinl2s
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Dopo la prima misura, prima di ogni frequenza e presente un ritardo di
sincronizzazione.

10.000000 MHz
Syncin2s
Att:88.0 dB

A fine misura comparira la tipica schermata “Spot Done” della modalita Wizard. D

E’ possibile ripetere il test (ReDo) o iniziare a misurare il prossimo (se presente)
punto. (Next).

Sia in Wizard che in Standard c’€ un tempo limite per effettuare le misure entro il
guale e necessario riconnettere le unita RX e TX.

Questo tempo limite € necessario per evitare errori imputabili a ritardi di lungo
termine sugli orologi interni.

Il timer si avvia nel momento in cui si schiaccia il tasto Unc.

Dopo 14 minuti, il SEMS ci avvertira che e necessario risincronizzare le unita TX ed
RX connettendole tra loro tramite la chiave RS232/Wireless ed attendere la luce
verde fissa.

Re-Sync Needed
Connect RX-TX
then press OK

Abort OK

A quel punto, premere OK.
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Se la connessione ha avuto successo si vedra la seguente schermata:

Abort

Sync OK
Remove
Connections

A questo punto e possibile avviare la misura, (il timer da 14 minuti € stato riavviato).

Se la connessione non va a buon

fine (sitenga a mente che dopo 17 minuti l'unita

TX si spegne automaticamente) compare la seguente schermata:

Synchronizing
Transmitter

E dopo aver premuto OK:

Is
Abort

Could not Sync

Failed
TX connected?
OK

In questo caso, controllare la connessione con il TX e nel caso riaccendere l'unita.

Fatto cio, riprovare premendo OK.
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3.9. Modalita Prequiet

Alcuni ambienti schermati sono naturalmente rumorosi. Il rumore di fondo di un
ambiente schermato puo ridurre notevolmente la qualita di una misura.

Per evitare cio si puo utilizzare la funzione Prequiet.

Nella modalita Prequiet il SEMS RX sposta leggermente le frequenze di lavoro in
modo che il rumore ambientale cada al di fuori dei punti di misura.

La modalita Prequiet & disponibile sia per misure wizard che standard, ma non puo
essere usata per misure Unconnected..

In entrambi i casi, € necessario azzerare prima il sistema, e poi, dal menu Meas,
accedere alla funzione PreQ.

In modalita Standard:

i SEMS B

Ready for Measuring

Auto Man PreQ Unc
Il Il Il Il

E in modalita Wizard:

N Fully Zeroed N
Ready for Measuring

Auto Man PreQ Unc
Il Il Il Il
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Appena la procedura di Quieting e terminata & possibile avviare una nuova misura

| Quietening N

Terminated

Meas Show Cal Snif
Il Il Il Il

Premendo Meas e iniziando una nuova misura, il SEMS utilizzera automaticamente
la lista ottimizzata di frequenze.
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3.10. SEMS LIGHT

All’'accensione il display dell’'unita RX si presentera cosi:

WIZ

FW —1.32 27/03/14

SEMS B

HW-Light
Std Cal Stp

Il SEMS Light ha le stesse funzionalita e performance del SEMS, unica limitazione &

sulla frequenza massima di lavo

ro fino a 128 MHz

Tramite il menu “Stp” & possibile upgradare il SEMS LIGHT per la funzionalita fino a
300 MHz tramite attivazione “Code0”

SEMS N

FW —1.32 27/03/14

HW-Light

BEEP Clear CodeO

e successivo inserimento chiave di sblocco

Please enter CODE

Enter to confirm
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Il codice da inserire viene fornito dalla MPB tramite I'opzione Key-300

Dopo aver inserito il codice di sblocco, comparira la seguente schermata

OFF then on again

Abort

Code saved
Turn the SEMS

OK

E dopo aver premuto “OK” il SEMS sara pronto per misurare fino a 300 MHz.
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4. SEMS PC Utility software, controlli e funzioni.

4.1. Installazione

Inserire il drive USB, in dotazione con il sistema SEMS ,nel PC in cui si sta

installando il software.
ﬁ\ SEMS SW.exe
( ) Setup Application

Aty 2010

Lanciare il file setup (SEMS SW.exe) e cliccare Sl nella finestra pop up (solo per

chi utilizza Vista e 7):

Change when theis notifscation: wpe

A seconda delle impostazioni del computer, l'installer del SW SEMS dara
istruzioni sullo schermo in lingue diverse.

Benvenuto

Benvenuto al programma di installazione di SEMS Software
122

E" wivamente consigliato uscire da tutti | programmi Windows
prima di continuare con questa installazione

Se ci sono altd programmi in esecuzione, prego premens
Annulla & chiudere questi programmi prima di rilanciare

linstallazione

Altimenti premere Avanti per continuare

Indietro | ,WI Annulla

Seguire le istruzioni per completare l'installazione
Attenzione! Dal sistema operativo Windows 7 in su necessario lanciare il
software SEMS_SW con tutti i permessi del’amministratore
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1)
2)

3)

4)

5)
6)
7

4.2. Connettere lo strumento

Inserire il cavo RS232/USB in dotazione nel computer

Se si utilizza Windows 7, premere Start, andare in Pannello di controllo-—>
Hardware e Suoni-—->Gestione Periferiche.

Se si utilizza Windows XP premere Start, andare in Pannello di controllo->
Sistema-—->Hardware--> Gestione Periferiche.

Prendere nota della porta COM dove & mappata la USB del cavo in
dotazione(Es. COM3):

g IDE ATA/ATAPI controllers

5 Imaging devices

== Keyboards

}wj Mice and other pointing devices
& Monitors

&* Network adapters

477 Ports (COM & LPT)
: Y= Prolific USB-to-Serial Comm Port (COM3)

L.} Processors
-% Sound, video and game controllers

/M System devices

- @ Universal Serial Bus controllers

Collegare l'unita RX del SEMS al connettore RS232 e accendere l'unita.
Awviare il SW SEMS dal desktop o dal menu start.

Aprire “I'opzione” menu, clicca su “ select Comm” e nella nuova finestra
inserire il numero annotato poco prima. Premere il tasto Enter sulla tastiera
per confermare.

Il programma dovrebbe essere correttamente configurato per comunicare con l'unita
RX del SEMS.

Nota: Si prega di usare la versione driver in dotazione con il SEMS per il cavo
RS232/USB in dotazione.
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4.3. Richiamare una misura

Attraverso il menu degli strumenti € possibile accedere a diverse funzioni per
interrogare l'unita RX.

L semsDefouit s
File Option [Tools ?

Retrieve » Single Measure

Update Firmware Set Of Measure

Get CalK Report

- Measure

e Single measure scarichera una singola misura precedentemente salvata
nella memoria del SEMS.

e Set of measure scarichera i dati relativi ad una specifico set di dati di una
camera.

e Get CalK Report scarichera | dati relativi all’'ultima procedura di calibrazione
effettuata con il CalKit ( un file TXT verra creato insieme al report).

| [ Retrieve - l":' (s eS| w

y P -1.15 04/06/10 P - 1.15 04/06410

0:0.010000 To 4.000000
1:0.01 0000 Te 300.007000

Save

Retriewve

Cliccando sull’elemento desiderato e premendo Retrieve, | dati verrano scaricati
dalla memoria interna del SEMS e mostrati sulla finestra principale (verra chiesto di
salvare un file record opzionale per quest’ultimo riferimento)
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Per richiamare una singola misura accedere all'opzione dal relativo menu (Tools ->
Retrieve -> Single Measure) e selezionare dalla finestra pop up la misura
desiderata:

15,7 SAVE Record as

| Fw-1.15 04/06/10 i . <« Program Files » SEMS Software » B

Organize v New folder

8 Downloads  ~  Name E Type
0:0.010000 To 4.000000 i Recent Places e )
10,01 0000 T 200.007000 — @ ChamberA 25/02/2011 11 File folde
‘ Uninstall 25/0 :02 File folde i
] defauttSMR

4 Libraries

5 Documents
J’ Music

(=] Pictures
¥ videos

% Computer
T

«
File name: | MUV RENURSI

Cliccando Retrieve verranno aggiornati | dati correntemente mostrati sullo schermo
con le misure richiamate, con possibilita di salvarle in un file record .SMR.

Sotto é riportata la tabella di correlazione tra gli index delle misure e gli slot di
memoria:

Memory Slot Index
0

L1

L2 1
L3 2
L4 3
M1 8
M2 9
M3 10
M4 11
H1 16
H2 17
H3 18
H4 19

Per consultare di nuovo questa misura, utilizzare solo il tasto Load dal menu e
selezionare il relativo file record.
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Per richiamare tutti i dati relativi ad una camera & necessario cliccare su Retrieve ->
Set of Measure dal menu Tools, poi selezionare il set di dati dalla finestra pop up.

| B9 Retrieve . LEIM
Fw/ -1.15 04/06/10

[ Retrieving Chamber B, Range: 1 Spot: 1

[Chamber 4, Range:1 , [Measures:1

In questo esempio stiamo richiamando dei dati dalla camera B, range 1.Come si
puo notare la finestra mostra il numero di misure relative ad ogni set (in questo
caso, 4 diversi punti).
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A fine download non viene richiesto di salvare | dati: questo perche il SEMS salva
automaticamente i set di misure all'interno della cartella di lavoro propria.
Per consultare tutti i dati della camera, basta cliccare su File -> Load

<« Program Files » SEMS Software »

Organize v New folder

B Downloads ~ *  Name ate mo Type

%1 Recent Places

A Chamber A 2 File foldef
4 Chamber B 2:2 File foldey

Uninstall File folde
] defaultSMR

i Libraries

&, Local Disk (C)

[alt ApplePhone

File name: | [WETYESNE

| punti di misura si trovano all'interno della cartella “Chamber B”, organizzati in
sottocartelle relative all’antenna (range) utilizzata.
Selezionando uno dei file SMR la finestra principale aggiorna i dati con quelli relativi

al punto selezionato.
Si apre una nuova finestra per facilitare all’operatore una osservazione d’insieme di

tutti i punti di misura:

| Spot_2.SMR
[l |spot_3smA
Spol_4.5MR

8c

3 Program Files
Y SEMS Software
3 Chamber B

| & Range 1

Nella parte inferiore della finestra & possibile navigare attraverso le cartelle di lavoro
e selezionare la camera/range desiderato, mentre nella parte superiore sono
mostrati i punti di misura contenuti nelle relative cartelle,.

E’ possibile selezionare uno di questi punti e aggiornare i dati mostrati sulla finestra
principale semplicemente cliccandoci sopra.
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4.4. Programmare una lista di frequenze con Scan o con
List

Nel menu List del software SEMS PC Ultility e possibile programmare una lista o
una scannerizzazione di frequenze da trasmettere direttamente al ricevitore RX per
la sua programmazione.

La schermata di seguito rappresenta il menu di lavoro per questa modalita:

M 5Ews:10-300000 Al
e Ooson Toos 2

Frequency DAHa]
sen [F
Swifies Wy
SwpFied 0000 g0
Fieq Sieo P
N° of P (0
] Ediate Lt
= ). Li

Se si vuole programmare una Scannerizzazione bisogna impostare la frequenza di
start, quella di stop e decidere gli step di avanzamento in percentuale.

Per crearne la tabella bisogna cliccare sul bottone “Write List”:

List
Frequency [MHz]

0.040000 A
0.042000

0.044100 Nekes

0.046305 ® Scan O List
0.048620

0.051051

0.053604

0.056284

0.059098 Sean List

0.062053

0.085156

0.068414 Start Freq. 0.04 MHz
Somne Stop Freq 4 MHz Remove Save soan as Sc3

0079197 Freq. Step 5 I nsert

rrrrr

Save scan as Scl

Save scan as Sc2

@
g
i
@
o
8
3
o
s
@
=
&

T Save scan as Scé
Modify

D7oicrs
0101078 Write List

0.181522 ¥
N of Points

[] Editable List

Per poi memorizzarla sul ricevitore RX cliccando su una delle quattro memorie
disponibili.
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Se diversamente si vuole creare una Lista di frequenze, basta cliccare sul riquadro
“List” e attendere I'abilitazione del riquadro “Edit Frequency”:

Edit Frequency

Remove

Insert
Madify 0.010000 IV

Per la crezione della lista sara sufficiente cliccare il pulsante “insert”, scrivere la
frequenza nell’apposito riquadro a fianco, e confermare cliccando nuovamente
“‘insert”.

Si prosegue nel medesimo modo qualora I'operatore voglia modificare o rimuovere
una frequenza.

Dopo aver impostato minimo 3 frequenze, il riquadro di salvataggio delle liste si
abilita:

Store Scans on SEMS

Save list as L1

Save list as L2

Save list as L3

Procedere con la memorizzazione della tabella su una delle tre liste proposte da
salvare nella memoria del ricevitore.
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NB:

In fase di programmazione, per abilitare la funzione:

“Unconnected mode” max 20 frequenze

“HiDyn” max 30 frequenze.
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4.5. Lavorare con i risultati

e Il colore del grafico pud essere cambiato da Options -> Graphic Color.
e |’asse di riferimento pud essere modificato cliccando due volte il massimo e
il minimo valore dell’asse e inserendo il valore desiderato.

i=m

100 MH? 30N kMH

e E’ possibile modificare i dati del diagramma dall’attenuazione all’efficienza di
schermatura da Options -> Diagram Style

e Usando il menu File é possibile salvare (save) o caricare (load) un file
record, o esportare (export) i dati in formato CSV\ASCII .

e Per l'inserimento del marker si deve cliccare su un qualsiasi punto sul
grafico. Un riquadro indichera il valore di attenuazione e la frequenza.

(se il riquadro e giallo il punto di misura si trova al di sotto del range di
dinamica dello strumento)

98.78 dB.
144885 kHz
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4.6.

Aggiornamento Firmware

Si puo aggiornare il firmware del Ricevitore e del Trasmettitore.

Assicurarsi che i file del firmware siano collocati nella cartella del software SEMS.

Ricaricare le batterie dell’'unita e connetterla al PC usando il cavo RS232.
Accendere l'unita, lanciare il software SEMS e selezionare la porta COM nel menu
Opzioni premendo Select Comm.

Per verificare I'assegnazione della porta COM controllare dal PC il pannello di
controllo, Sistema, Hardware, Periferica, porte.

Per avviare la procedura di aggiornamento del firmware cliccare il tasto “Tool”,
Update Firmware, e poi Update Rx o Update Tx.
Supponendo che si stia aggiornando l'unita Rx, apparira la seguente schermata:

« Form1 EEX

Make sure SEMS RX is OFF
Then Turn it ON

Spegnere il ricevitore e riaccenderlo di nuovo.

Sara visualizzata la finestra di aggiornamento

= Form1 BEE]

[ems_Fix BIN © FPGA

|SemsFu.ldr & Fimiw/ are

Update Firmware
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Il file aggiornabile (SemsFw.ldr) si trova nella directory del software SEMS.
Premere il tasto “Update Firmware” e attendere il caricamento.

Non appena I'aggiornamento & completo, chiudere la finestra e spegnere il
ricevitore.

Maggiori informazioni: www.gruppompb.com
Informazioni tecniche: assistenza@gruppompb.com
Telefono+39 06 41200744
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